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I. Introduction.
The majority of this tutorial is derived from the Biacore manual, Getting Started BIACORE® 3000. This
tutorial is designed to acquaint the user with the basic operating principles and procedures of the Biacore
3000. In general, most experiments will follow this same format although there will be differences in the
coupling step depending on which sensor chip and/or immobilization chemistry is used.
For Further Reading:
1. Getting Started BIACORE® 3000
2. BIACORE 3000® Instrument Handbook
3. BIAtechnology Handbook
II. The Basics:
Biacore experiments are setup in the following manner generally:
a. Immobilization: One of the interactants is immobilized to the surface of the sensor chip using
coupling chemistry. The immobilized interactant is thus referred to as the ligand.
b. Binding: The interaction partner is injected across the ligand-immobilized surface resulting in
binding. The interaction partner in solution is referred to as the analyte.
c. Regeneration: The bound analyte is removed from the surface of the sensor chip through the
injection of a regeneration solution.
d. Controls: Controls should be set up during the experiment to test for non-specific binding and to
verify that the observed binding is from the interaction being studied.
The steps covered in this tutorial are specific to the interaction of myoglobin to immobilized antimyoglobin antibody. While this procedure is designed for this antibody-antigen interaction, the protocol
can be easily adapted for another interaction. The following steps will be covered in this tutorial:
a. Immobilization of Anti-Myoglobin Monoclonal Antibody (-Myo MAB) via amine coupling. Optimal
immobilization conditions will be sought through a series of test injections.
b. Myoglobin will be injected and the optimal regeneration conditions for the -Myo MAB will be
deduced.
c. Non-specific binding of myoglobin will be tested through injection over a blank reference surface.
III. Pre-Experiment Notes.
a. Buffer: Buffer should always be degassed and filtered (0.22um filter) before diluting the samples.
The purpose of degassing is to prevent the injection of air into the system which can cause signal
spikes that obscure the data. Filtering prevents the injection of particulates into the system which
may non-specifically bind and/or clog the microfluidics system.
b. Be sure to have all the reagents in the proper rack position before starting a method or using the
manual commands. Incorrect rack positions can cause the injection needle to hit the rack and
may cause the needle to bend.
c. Instrument damage is a serious matter and if it occurs, the user will be billed for the
troubleshooting, repairs and replacement parts necessary to get the instrument running again.
d. It is essential to always leave the instrument with buffer or water running at a low flow rate
post-experiment. Letting the instrument run dry can cause serious damage.
e. The Biacore supplies (vials, caps, etc.) in the core are part of the per-hour cost of the instrument
and are free for use. Sensor chips are available in the facility but are available for purchase at the
facility’s cost.
f. The nomenclature used in Biacore to denote rack positions is as follows:
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Figure 1. Rack Positions demonstrated. R1 always corresponds to the leftmost reagent rack in the instrument while
R2 corresponds to the rightmost

IV. Materials
1. CM5 Sensor Chip
2. N-(3-Dimethylaminopropyl)-N’-ethylcarbodiimide (EDC)
3. Ethanolamine
4. N-Hydroxysuccinimide (NHS)
5. P20, P200 and P1000 Pipetters and tips
6. Biacore Vials
7. Eppendorf Vials (0.6mL)
8. BiaDesorb Solutions 1 and 2
9. The Following Solutions (All Found in the Getting Started Reagent Kit):

Fig 2. Reagent Solutions Necessary for the Tutorial
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V. Preparing the System with a New Sensor Chip.
1. In the Biacore Software, go to the Tools Menu and select Working Tools. Under working tools
select Desorb and follow the on-screen instructions. Desorb should be run prior to any to clean
the system of adsorbed material. This procedure takes approximately 15mins and should always
be run with the Sensor Maintenance Chip docked to the system.
2. Undock the Sensor Maintenance Chip from the system by going to the Command Menu and
selecting Undock. Check Empty Flow Cells and hit Undock. Wait for the sensor chip to
undock, at which point the Sensor Chip light on the front of the instrument will begin to blink.
3. Pull down the sensor chip cover on the front of the instrument, slide the cover back to release
the chip and remove the Sensor Maintenance Chip from the instrument. Place the CM5 Sensor
Chip in the instrument, lock the sensor chip into place and close the cover on the port.
4. Select Dock on the dialog box and replace the buffer container with one containing the buffer for
the experiment. Allow the system to Prime by hitting Start.
5. Prime the system twice by selecting the option under the Working Tools in the Tools Menu.
Repeat this procedure after the first Prime has been completed.
Note: Always prime 3x when switching running buffers as this will remove any of the
previous buffer from the system and improve results.
VI. Optimization of pH for Immobilization.
The following procedure is designed to optimize the pH of the immobilization buffer to maximize
immobilization to the surface. Efficient immobilization for amine coupling results from the electrostatic
pre-concentration of ligand on the surface. To accomplish this pre-concentration, the ligand must be
positively charged and thus must be in an immobilization buffer 0.5 – 1 unit in pH below its pI.
A more detailed description of the amine coupling process can be found in the BIAapplication
Handbook, section 4.2.
1. Dilute the ligand from 1mg/mL to 30ug/mL by the following:
a. Place 97uL of each coupling buffer (pH 7.0, pH 6.0, pH 4.8, Coupling buffers 1,2 and 3,
respectively) into separate Biacore plastic tubes.
b. Add 3uL of ligand to each tube
c. Flick the bottom of the tube to mix
2. Place the plastic vials in the rack positions R2D1, R2D2 and R2D3, respectively
3. Place a vial containing Regeneration Solution 3 (10mM glycine, pH 2.0) into rack position R1D3.
4. From the Run Menu, select Run Sensogram… to begin taking data
a. Select Fc2 for both flow and detection and click OK
b. Enter a flow rate of 10uL/min
5. Queue up commands in the queue to inject all three ligand solutions by the following:
a. Form the Command Menu, select QUICKINJECT from the menu
i. Enter position R2D1
ii. Enter 20uL for the injection volume (2min)
iii. Click on the start button
b. Repeat the same procedure for positions R2D2 and R2D3. The commands will be saved
on the queue and performed in sequence
c. Queue another QUICKINJECT of 20uL of the Regeneration Solution in position R1D3.
Note: The surface has not been activated using NHS/EDC yet so there should be no amine
reactive moieties on the surface and thus there should be no coupling of the ligand to the
surface.
6. Wait for the injections to finish.

http://biomol.uchsc.edu/cores/biophysics/main.html

University of Colorado Denver, Biophysics Core Facility

August 2008

Biacore Tutorial
4
7. Compare the results with the following sensogram:

Figure 3. Anticipated Results from an Immobilization Buffer Optimization

There are several things to note about the sensogram obtained:
i. At pH 7.0 (the first injection) the pH is very close to the pI of the protein. In
these conditions, the protein carries a minimal positive charge and thus a
minimal attraction to the negatively charged matrix of the CM5 chip.
ii. At pH 6.0 and 4.8, the protein becomes more progressively positively charged
which increases the affinity of the analyte for the matrix.
iii. The pH 6.0 buffer is the optimum choice as it creates enough positive charge on
the protein to attract it to the matrix but at a pH that provides a milder
environment for the protein. As a rule of thumb, the level of attraction should
always exceed the desired immobilization level.
8. Select the Run Menu and select Stop Sensogram from it. Click Yes to stop data collection and
Yes if the program asks to clear the command queue.
9. Use the Save As function under the File Menu to save the sensogram under a folder with the
user’s name on it.
10. Place the instrument in Standby by selecting the Tools Menu, then Working Tools and finally,
Standby. Ensure enough buffer solution is in the buffer container to last for a few days
(~80mL).
VII. Immobilization and Surface Binding Capacity Check.
1. Mix a fresh 1mL solution of 0.5M NHS/0.2 M EDC. Place 200uL of this solution into a plastic
Biacore vial in rack position R2A1.
2. Mix 4uL of the ligand (-Myo MAB) stock solution with 396uL of 5mM maleate (pH 6.0, Coupling
Buffer 2). Place 100uL of this solution into a Biacore vial in rack position R2A2.
3. Place 200uL of 1M Ethanolamine Hydrochloride (pH 8.5) into a vial in rack position R2A3.
4. Place ~2mL of degassed HBS-EP Buffer into a glass vial in rack position R2F3.
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5. Select the Run Menu and select Start Sensogram…
a. Set the system to flow over Fc1 and detect over Fc1-4
b. Set a flow rate of 5uL/min
6. Queue the following commands (from the Command Menu):
a. QUICKINJECT of 35uL of R2A1 (the NHS/EDC solution)
b. QUICKINJECT of 5uL of R2F2 (HBS-EP)
c. QUICKINJECT of 35uL of R2A2 (the ligand)
d. QUICKINJECT of 5uL of R2F2 (HBS-EP)
e. QUICKINJECT of 35uL of R2A3 (Ethanolamine)
f. QUICKINJECT of 5uL of R2F2 (HBS-EP)
g. FLOWPATH Fc2 (switches flow to Fc2)
h. QUICKINJECT of 35uL of R2A1 (the NHS/EDC solution)
i. QUICKINJECT of 5uL of R2F2 (HBS-EP)
j. QUICKINJECT of 35uL of R2A3 (Ethanolamine)
k. QUICKINJECT of 5uL of R2F2 (HBS-EP)
Note: This conditions two parallel surfaces, one containing the ligand for kinetic analysis and
another surface with no ligand as a reference.
7. Compare the results gathered with the following figure:

Figure 4. Sample Immobilization Sensogram.

8. Calculate the theoretical binding capacity of the surface (Rmax) using the following formula:

MWanalyte = Molecular Weight of the analyte = 17500 Daltons (myoglobin)
MWligand = Molecular Weight of the ligand = 156000 Daltons (a-myoglobin MAB)
Amount Immobilized = RU difference between points a and g
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Stoichiometric Ratio = 2 (Each antibody can bind two antigens)
The Rmax Obtained from the Sample Sensogram is 1571 RU. Generally, 50-400 RU surface binding
capacity is considered optimal for most kinetics experiments.
9. Select the Run Menu and select Stop Sensogram
10. Save the sensogram as was done before (File Menu then Save As)
11. Ensure the system is put into Standby so the system isn’t run dry
VIII. Regeneration and Nonspecific Binding Test
The purpose of this exercise is to determine the optimum regeneration conditions for the analyteligand pair using a series of low pH solutions. In order to retain ligand functionality on the surface,
the solutions will be tested from mild to harsh conditions.
An additional step in this analysis is to estimate the non-specific binding of the analyte by the
surface. This is an important validation step that verifies that the observed binding phenomena are
ligand-analyte interactions and not non-specific adsorption of the analyte.
1. Dilute the analyte solution by adding 24uL of the stock myoglobin solution to 376uL of the HBSEP buffer. Final concentration should be ~5ug/mL. Cap the vial, mix by flicking the base of the
vial and place the vial in R2A1.
2. Place 200uL of Regeneration solutions 1 (10mM acetate, pH 4.0), 2 and 3 (10mM glycine pH 3.0
and 2.0, respectively) into separate Biacore plastic vials and place the vials in rack positions
R2B1, R2B2 and R2B3, respectively.
3. Select the Run Menu and select Run Sensogram…
a. Set the detection and flowpath to Fc1-2
b. Set the flow rate to 10uL/min
4. Inject the analyte solution by selecting the Command Menu and then selecting Inject…
a. KINJECT 30uL of the solution R1A1. Enter a disassociation time of 180s
5. Queue up the following commands:
a. QUICKINJECT 10uL of R2B1 (Regeneration Solution 1, ph 4.0)
b. QUICKINJECT 10uL of R2B2 (Regeneration Solution 2, ph 3.0)
c. KINJECT 30uL of the solution R1A1. The purpose of injecting the analyte again is to
ensure that the regeneration doesn’t harm the ligand on the surface. Disassociation time
again should be 180s
d. QUICKINJECT 10uL of R2B3 (Regeneration Solution 1, ph 2.0)
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6. Compare the sensogram obtained with the figure below:

Figure 5: Sample Regeneration Experiment

7. Next examine the sensogram for Fc2 for non specific binding.
a. The baseline RU value before and after injection with the analyte should be equal if no
non-specific binding is occurring.
8. The stability of the surface after repeated regeneration must be tested to ensure no ligand is lost
with repeated regenerations. Queue up the following commands:
a. KINJECT 30uL of R1A1 (ligand), Dissociation time: 180s
b. QUICKINJECT 10uL of R2B3 (Regeneration Solution 1, ph 2.0)
c. KINJECT 30uL of R1A1 (ligand), Dissociation time: 180s
d. QUICKINJECT 10uL of R2B3 (Regeneration Solution 1, ph 2.0)
e. KINJECT 30uL of R1A1 (ligand), Dissociation time: 180s
f. QUICKINJECT 10uL of R2B3 (Regeneration Solution 1, ph 2.0)
9. Examine the resulting sensogram taking note of the baseline after each regeneration injection. If
the baseline decreases after subsequent regeneration cycles, than the regeneration is probably
damaging/removing the ligand on the surface and is too harsh. If the baseline slowly rises after
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subsequent regeneration cycles, than analyte is being left on the surface and the regeneration
needs to be tweaked.
10. Save the sensogram in the proper directory and ensure the system is put into Standby.
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